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Section 8.1.1. Introduction to GIS
Geographic Information Systems (GIS) are the combination of computer hardware, software,
data, and personnel, which makes it possible to describe and characterize the earth and other
geographies for the purpose of visualizing and analyzing spatially referenced information.
Broken down, the components of GIS are:
Geographic: a location at various levels of aggregation, e.g. a country, city, or a protected
national forest.
Information: information about the location, e.g. population, number of sick or healthy people,
species of animals sampled, etc.
Systems: helps capture, store, manipulate, analyze, manage, and present the above.
In short, GIS combines geographic data (latitude and longitude) and non-geographic
information about the location (attributes like population or land use) with the help of software
like ArcGIS, QGIS, GRASS, etc. This tutorial is designed to introduce you to QGIS, which is a free,
open-source software. You will gain an understanding of some basic processes that can be
executed using QGIS, like opening digital maps on your computer, creating new spatial
information to add to a map, and creating printed maps customized to your needs.
Before you get started, it will be helpful to acquaint yourself with some basic GIS concepts.
A common function of GIS Applications is to display map layers, which are spatial data
representing something in the real world –– a roads layer for example will have data about the
street network. Map layers mainly consist of two types of spatial data to represent their
information:
1. Vector data represent information as points,
lines, and areas and are most appropriate
when used to represent discontinuous data,
e.g. houses, rivers, national parks, etc.
2. Raster data represent space as a continuous
field consisting of squares (called pixels) of a
standard size, and are most appropriate
when used to represent continuous data,
e.g. land cover, soil maps, etc.
Fig1. Different GIS information layers, stacked
together.Source: National Coastal Data Development
Centre (NCDDC), National Oceanic and Atmospheric
Administration (NOAA), USA
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Every GIS dataset has a coordinate system, which is a reference system used to represent the
locations of geographic features, imagery, and observations such as GPS locations within a
common geographic framework. Put simply, a coordinate system helps enable every location
on the earth to be specified by a set of coordinates of known location (latitude and longitude)
on a grid. Data is represented using either a geographic coordinate system or a projected
coordinate system:
1. A Geographic coordinate system (GCS) uses a three-dimensional spherical surface to
define locations on earth via latitude and longitude values.
Horizontal lines of latitude run parallel to the equator. Lines of latitude in the northern
hemisphere are positive ranging from 0 degrees at the equator to 90 degrees at the
North Pole. Lines of latitude in the southern hemisphere are negative ranging from 0
degrees at the equator to -90 degrees at the South Pole. Vertical lines of longitude are
parallel to the prime meridian, ranging from 0 degrees (at the Prime Meridian) to a
positive 180 degrees in the eastern hemisphere and 0 to -180 degrees in the western
hemisphere.

Fig 2. The geographic coordinate system.
(Source: http://www.plux.co.uk/converting-radians-in-degrees-latitude-and-longitude/)

2. A projected coordinate system is defined on a flat, two-dimensional surface. Unlike a
geographic coordinate system, a projected coordinate system has constant lengths,
angles, and areas across the two dimensions. This enables accurate measurements of
distance, angles, and areas.
Since projected coordinate systems are based on a sphere that is projected onto a flat
plane, the coordinate system defines, with the help of coordinates, how the twodimensional, projected map in your GIS is related to real places on the earth.
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Projected coordinate systems are often referred to as projections, and the choice of
which coordinate system to use (there are many options, common ones being Universal
Transverse Mercator (UTM), Lambert Conformal Conic, and Albers Equal Area) depends
on the regional extent of the area your work is in and on the analysis you want to
conduct. A discussion about the different types of projected coordinate systems is
beyond the scope of this basic introductory section; for more information, refer to the
glossary and helpful links sections of this tutorial. It is important to understand,
however, that a projected coordinate system is always based on a geographic
coordinate system that is based on a sphere or spheroid (which represents earth).

Projected coordinate
system

Geographic coordinate
system
Fig 3. Mapping spherical data to a flat surface.
(Adapted from: https://developer.apple.com, “Displaying Maps”)

Uses of GIS:
GIS has been widely employed in government, business and commerce, transportation, health,
and natural resource sectors. It has been used for urban planning, resource allocation,
surveying, emergency and disaster management, and tracking the occurrence and spread of
disease.
Apart from displaying geographic data, one of its most notable functions is the ability to
synthesize or combine geographic information to analyze and understand underlying patterns
that may not be obviously apparent. This process of finding patterns and trends to inform
decision-making is called spatial analysis.
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Using GIS, we can:


Summarize data associated with geographic features.



Find locations that meet specified criteria.



Identify, quantify and visualize spatial patterns.



Combine geographic data for further analysis.

Section 8.1.2. QGIS Official Training Guides
The official training and user guides for QGIS are very detailed in all aspects of using QGIS.
Listed below are links to User Guides and Training Manuals in different languages that may be
helpful for you if you wish to further your knowledge about everything QGIS has to offer. Note:
these guides are for QGIS Version 2.6; however, will still be useful in version 2.8 as the user
interface has not changed.
Brazilian Portuguese: User Guide - http://docs.qgis.org/2.6/pdf/pt_BR/QGIS-2.6-UserGuide-pt_BR.pdf
Training manual - http://docs.qgis.org/2.6/pdf/pt_BR/QGIS-2.6-QGISTrainingManual-pt_BR.pdf
English: User Guide - http://docs.qgis.org/2.6/pdf/en/QGIS-2.6-UserGuide-en.pdf
Training Manual - http://docs.qgis.org/2.6/pdf/en/QGIS-2.6-QGISTrainingManual-en.pdf
French: User Guide - http://docs.qgis.org/2.6/pdf/fr/QGIS-2.6-UserGuide-fr.pdf
Training manual - http://docs.qgis.org/2.6/pdf/fr/QGIS-2.6-QGISTrainingManual-fr.pdf
Hindi: User Guide - http://docs.qgis.org/2.6/pdf/hi/QGIS-2.6-UserGuide-hi.pdf
Training manual - http://docs.qgis.org/2.6/pdf/hi/QGIS-2.6-QGISTrainingManual-hi.pdf
Indonesian: User Guide - http://docs.qgis.org/2.6/pdf/id/QGIS-2.6-UserGuide-id.pdf
Training manual - http://docs.qgis.org/2.6/pdf/id/QGIS-2.6-QGISTrainingManual-id.pdf
Spanish: User Guide - http://docs.qgis.org/2.6/pdf/es/QGIS-2.6-UserGuide-es.pdf
Training manual - http://docs.qgis.org/2.6/pdf/es/QGIS-2.6-QGISTrainingManual-es.pdf
Note: When you download and install QGIS, 6 different programs will be downloaded. They are:
QGIS Desktop: This is the program you will be using for this guide. Here you can create,
edit, visualize, analyze, and publish geospatial information. QGIS Desktop can be
downloaded on Windows, Mac, Linux, BSD, and Android devices.
QGIS Browser: This program allows you to browse and preview your data and metadata
(data that describes and summarizes basic information about other data).
GrassGIS: This is another free and open source GIS software program. We will not be
using this; however, QGIS does have the ability through the tool box to use layers and
tools GRASS has to offer.
MSYS: This program allows the building of applications; we will not be using this
program in this guide.
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OSGeo4Shell: This is a package of open-source geospatial tools for Windows; we will not
be using this program.
Saga GIS: This is another free and open source GIS software program; we will not be
using this software in this guide.

Section 8.1.3. Download QGIS
1. Go to the QGIS website to download the software.
a) http://www.qgis.org/en/site/
i) Click the “Download Now” button
ii) Choose your platform (i.e. Windows or Mac)
(1) For Windows
(a) Choose the QGIS Standalone Installer Version
2.8.1 (32 bit) OR QGIS Standalone Installer Version 2.8.1 (64 bit) (or current
version) depending on your operating system.
(b) Save the .exe file to your computer.
(2) Double click on the .exe you just downloaded and follow the instructions given
for installing the software.
(3) For Mac
(a) Click on the KyngChaos QGIS download page
(b) Click on GDAL Complete 1.11 framework package
(i) Click on the GDAL 1.11 Complete [39.0 MiB] 2015-3-4 version (or current
version) to download the file. Open the file you just saved.
(ii) Double click on the GDAL Complete.pkg file and follow the instructions to
install it on your computer.
(c) Go back to the KyngChaos QGIS download page
(d) Click on Matplotlib Python module
(i) Go down the page and click on matplotlib 1.3.1-2 [35.8 MiB] (Lion+) to
download the file. Open the file you just saved.
(ii) Double click on the matplotlib.pkg file and follow the instructions to
install it on your computer.
(e) Go back to the KyngChaos QGIS download page
(i) Click on QGIS 2.8.1-1 [163.8 MiB] to download the file. Open the file you
just saved.
(ii) Double click on Install QGIS.pkg and follow the instructions to install it on
your computer.
Visit the following YouTube link for a step by step video guide for installing QGIS
on a Mac: https://www.youtube.com/watch?v=AocxUop1RTE
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Section 8.1.4. Introduction to QGIS Interface
1) Open QGIS Desktop by clicking the icon added to the desktop, through the Start menu in
Windows, or through the Application folder on the Mac. Note: All screen grabs in this guide
are from the Windows platform, there may be some minor differences in the Mac version of
the software.
a) Components of the Geographic User Interface (GUI) when you open QGIS.
Menu Bar

Add
Data
Tool

Browser
Window
Map View

Map Legend

Status Bar
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b) Some important and useful tool icons.
New
Open

Pan Map

Add Vector Layer

Pan Map to Selection

Add Raster Layer

Zoom In

New Shapefile Layer

Save

Zoom Out

Save As

Zoom to Extent

New Print Composer

Zoom Full

Composer Manager

Zoom to Selection
Zoom to Layer
Refresh

c) The pull-down menus in the Menu Bar have
the same tools as listed above plus more. If,
however, you happen to close the Map
Legend or Browser Window, you can reopen
them by going to View/Panels and then click
the box next to the panel you would like to
open.
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Section 8.1.5. Data File Organization
For the remainder of the user guide, you will be using data which is provided with this guide.
You will want to unzip the folder called QGIS_Training_Data. Within the Data folder you will
find an Excel file and two folders, Rasters and Vectors, containing layers which you will be
adding to QGIS Desktop for the final goal of producing a map export. Note: Data provided with
this guide is for the purpose of teaching the user QGIS and in no way represents sampling
locations in Uganda for the PREDICT project. Rasters (land use layers) and shapefiles (Uganda
district and protected areas) are publicly available and website addresses can be found in
Section 8. Data Download of this guide. The Rodent_Sampling_Sites.xlsx contains 4 points
haphazardly chosen and in no way represents sampling locations in Uganda.
QGIS_Training_Data
Rodent_Sampling_Sites.xlsx
Raster folder:
1. Four land use layers (Africa_LandUse_31, _32, _43, and _44) for Uganda from the
International Steering Committee website. Each layer consists of the following components:
a. .tfw: contains the geographic information
b. .tif: image file
c. .xml: contains metadata for the file
2. International Steering Committee Website.doc: explains the symbology of the land use
layers
Vector folder:
1. Uganda_District_GAA (downloaded from the Global Administrative Areas website)
Components of the Uganda_District_GAA shapefile includes:
a. .dbf – attribute format; columnar attributes for each shape
b. .prj – projection format; the coordinate system and projection information
c. .sbn – a spatial index of features
d. .sbx – a spatial index of features
e. .shp – shape format; contains the feature geometry
f. .xml – geospatial metadata in XML format
g. .shx - shape index format; positional index of the feature geometry
2. Uganda_Protected_Areas (downloaded from the Protected Planet website) Components of
the Uganda_Protected_Areas shapefile includes:
a. .dbf – attribute format; columnar attributes for each shape
b. .prj – projection format; the coordinate system and projection information
c. .sbn – a spatial index of features
d. .sbx – a spatial index of features
e. .shp – shape format; contains the feature geometry
f. .shx - shape index format; positional index of the feature geometry
v.29Nov2016
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Section 8.1.6. Vectors
1. Adding vector layers to your map: There are two different ways you can add vector layers
in QGIS, either by going through the Browser Window or using the Add Vector Layer button
on the side of the QGIS screen.
a) Browser window in QGIS – Browse to where you saved the QGIS_Training_Data folder,
open the Vector folder, and double click on Uganda_Districts_GAA.shp. Notice the file is
now listed in the Map Legend window and visualized in the Map View window. Note:
The color of Uganda (or any vector file) will probably be different on your screen. We will
discuss how to change the symbology (color) later in this guide.
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b) Add vector button: click the Add Vector Layer button Note: you can also get to the Add
Vector Layer interface by going to the Layer menu, Add Layer, Add Vector Layer.
i) Click the Browse button
ii) In the browse window Navigate to
the QGIS_Training_Data folder,
open the Vector folder, and select
Uganda_Protected_Areas.shp
iii) Hit the Open button
iv) On the Add Vector Layer, click the
Open button.
v) Uganda_Protected_Areas.shp should now be added to the Map View and Map
Legend window.
vi) Hit the Save button to save the changes you have made to the project.
c) Saving a project: Now that you’ve added a layer let’s Save the project. Note: It is a good
habit to get into saving your project often as you work. QGIS has been known to crash,
causing you to lose work you
have completed from the last
time you saved.
i) Click the Save As button
and browse to the
location where you
would like to save your
project.
ii) File Name – Give your
QGIS project a name
iii) Click Save
iv) After the first time saving
your project, if you close
QGIS it will ask you if you
would like to save any
changes you have made.
d) Opening a project: Opening an existing QGIS project after closing the project
i) Click the Open icon
in QGIS and
ii) Or go to the Project drop-down menu and click open
iii) You can also double click on the project (.qgs) from within Windows Explorer.
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2. Making a new vector file
e) Select the New Shapefile Layer button
f) The New Vector Layer window will appear
i) Choose the Type of file you would like to make (point, line, or polygon). For this
example for Type choose Point. Note: A vector file can only support one type of data
at a time. So, for example, if you make a point file you cannot add lines or polygons
within that layer, but will have to make a new layer.
ii) Under New Attribute
(1) Next to Name type “Name”
(2) Type should be “Text Data”
(3) Width should be “80”
(4) Hit the Add to Attributes List button
Note: Once you do this you will notice
that the Name attribute now appears in
the list under Attributes list. This adds a
column in the attribute table so you can
name your points when you make
them.

(5) Now make a column that allows you to input the number of bats sampled at a
location. Under New Attribute, next to Name type “NumberBats”
(6) Type should be set to “Whole number”
(7) Accept the default for Width which should be “10”
(8) Hit the Add to Attributes List button
(9) Hit the OK button
(a) Browse to the Vector folder in QGIS_Training_Data and Name the file
BatSamplingLocations. You have now made a file to which you can add your
sampling locations (which we will do in the next section about editing vector
files).
3) Editing a Vector file
g) Before we start editing, zoom into the southwest corner of Uganda to the Bwindi
Impenetrable National Park. There are a couple of different ways to zoom to an area.
i) You can use the Zoom In
tool which allows you click on the image and the
image will zoom into that area at a set interval OR you can click and hold down the
button to draw a box around the area you want to zoom into.
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ii) You can also zoom in and out of the image by using the wheel of the mouse. Note:
The zoom function with the wheel of the mouse is always active, meaning it can
happen at any time unintentionally. It seems to happen a lot more easily with the
Mac mouse than with the traditional wheel mouse for windows. To turn this function
off go to the Settings pull-down menu and choose Options. Choose Map Tools and
under panning and zooming change Mouse wheel action to Nothing if you don’t
want anything to happen or you can choose another option and slow down the zoom
by changing the Zoom Factor to 1.1 (this is the slowest setting).
iii) You can zoom to a specific layer by right clicking on the layer in the Map Legend
window and choose Zoom to layer.
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h) In the Map Legend window highlight the point vector file just created
(BatSamplingLocations) and the click the Toggle Edit button.
i) Select the Add
Feature button
to
the right of the Toggle
Edit button
j) Click on the map within
the Bwindi Forest where
you would like to add a
point
k) A box will appear giving
you the opportunity to
fill in the attributes for
that point (these are the
attributes you specified
when you created the
point file).

i) ID: This should be a unique number for the point, so start
with 1 and continue from there as you add points.
ii) Name: Name of the site – For now, name it Bwindi 1
since the point is inside the park.
iii) NumberBats: Keep this blank for now. We will go in
and add the data later.

iv) Hit the OK
button and notice the
point shows up on the
map. If you cannot see
it, make sure that the
BatSamplingLocations
layer is the top file in
the Map Legend
window. If it is not the
top layer, just select it
and drag it up.
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v) Add one more point in the park and 2 outside the park. Give the points a
unique ID numbers and names. We will enter the number of bats at a
later time so for now just click OK.
vi) Click the Save Layer Edits button (this does not stop the editing but just saves what
you have done).
vii) If you realize that a point is in the wrong place, you can move that point
using the Move Feature(s) button.
(a) After clicking the button, click, and drag the point you wish to move
(be sure to save your edits!).
l) To edit data in the attribute table, right click on the name of the file in the Map Legend
window and select Open Attribute Table.

i) Once the attribute table is open you can change or delete any information. Here you
can add numbers for NumberBats attribute. Note: You have to be in Editing mode to
make changes in the attribute table.
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ii) Be sure to save the changes, and then close the attribute table
m) When done editing, click the Toggle Editing button again to close the editing tool. When
closing the Toggle Editing button it should ask you to save your edits if you didn’t save
before closing. Click Yes.
4) Import an Excel file into QGIS: This section explains how to bring an Excel file containing
your data into QGIS. You can use the Rodent_Sampling_Sites.xlsx file in the
QGIS_Training_Data folder for this example.
a) Before you import an Excel file it must be saved as a comma delimited file (.csv). Steps
for that follow:
i) Open the Rodent_Sampling_Sites.xlsx Excel file in the
QGIS_TrainingData folder. Go to the File menu and click
Save As.
ii) The Save As window will open,
Save as type: Chose CSV (Comma delimited) Important!
for Mac choose Windows Comma Separated (CSV).
(1) Name: Name the file if it didn’t retain its name (in this
case, it is already named Rodent_Sampling_Sites).
(2) Hit the Save button
(a) Click OK to “The selected file type does not support workbooks that contain
multiple sheets” warning.
(b) Click Yes to the next warning “Rodent_Sampling_Sites.csv may contain
features that are not compatible with CSV (Comma delimited). Do you want
to keep the workbook in this format?”

(3) Go back into QGIS.
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b) Back in QGIS Desktop click the Add Delimited Text Layer button.
i) The Create a Layer from a Delimited Text File box will pop up.
ii) Browse to the .csv you saved. Once you add the file, double check that information
in the other boxes (i.e. X and Y fields, and data from the Excel file) automatically got
filled in. If not, activate the circle next to CSV (comma separated values).
(1) Double check that under the heading Geometry definition:
(a) Point coordinates is activated.
(b) X Field = Longitude.
(c) Y Field = Latitude.
Note: If you are using Degrees Minutes Second instead of Decimal degrees be
sure to activate the box next to DMS coordinates.
(d) Once you have checked your settings and data, click OK.
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(e) Next, you will be asked
to choose your
coordinate system for
the file. If the coordinate
system you are using is
under Recently used
coordinate reference
systems you can
highlight it there and
click OK. If not, choose
the correct coordinate
system under Coordinate
reference systems of the
world. For this exercise,
we will use WGS 84.
(f) Click OK.
(g) Your data points should
show up in the Map View window and the file should now be listed in the
Map Legend window. Note: This file cannot be edited (toggle edit button is
grayed out), and therefore must be saved as a shapefile.
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5) Convert an imported .csv layer into a shapefile:
a) Right click on the .csv layer you just imported into QGIS (Rodent_Sampling_Sites) and
select Save as.
b) The Save vector layer as…box will appear.
i) Format = ESRI shapefile.
ii) Save as – Click the Browse button and browse to
the location you would like to save the file. Be sure
to name the file and click Save.
iii) Set the CRS (coordinate reference system) to
Layer CRS if you specified the coordinate system
when importing the .csv.
iv) Accept all other defaults and click OK. Note: There
are now 2 files called Rodent_Sampling_Sites. The
one on the top is the new shapefile. You can
remove the second one by right clicking and
choosing Remove. Notice that when you now click on the shapefile just added to the
Map Legend window, the Toggle Edit button is now selectable. You can now make
edits to the point locations and attribute table the same way as listed above.
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6) Properties of a vector layer: Once you add a vector you can change
the symbology (i.e. color), coordinate system, and label features for
a file by going to the Properties menu.
c) In the Map Legend window right click Uganda_District_GAA and
choose Properties from the popup menu. Below are descriptions
of some of the tabs which might be useful.
i) General tab: Here you can see the layer name, location, and
coordinate system (which you can change by clicking Specify)

v.29Nov2016

PREDICT Operating Procedures: QGIS - 21

ii) Style tab: Here you can change the symbology (i.e. color and transparency) of the
layer. While here we are going to change the Fill for this layer.

(1) Click on Simple Fill (you will notice the options on the right side of the screen will
change).
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(2) On the right side of the screen click the arrow next to Fill style and choose No
Brush. Click Ok. Notice in the Map View window you now only see the lines from
the Uganda_Districts_GAA layer; any color is visualizing the
Uganda_Protected_Areas layer.
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iii) Labels tab: Open the Properties tab again for Uganda_District_GAA as described on
page 21, and select the Labels tab. Here you can add labels based on an attribute by
activating the Label this layer with and then choosing the attribute in the pulldown
menu.
(1) Click on the box next to Label this layer with. Choose “NAME_1” from the pull
down menu. Hit Apply. Notice that the names of the districts are now visualized
on the map. You can then change font, color, etc. of the label as well. Deactivate
Label this layer with by clicking on the box in front of it before proceeding.

iv) Now change the symbology for Uganda_Protected_Areas, BatSamplingLocations,
and Rodent_Sampling_Locations. This time, however, since we want the
Uganda_Protected_Areas and sampling locations to have color you can simply
choose a different color without choosing Simple Fill.
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v) For the point locations feel free to choose different colors, symbols, and sizes, all of
which can be found in the on the Style tab as well.
vi) Save your project if you haven’t recently. Note: From this point on the images in this
guide might differ a little visually depending on the symbols you have chosen to
represent your data.
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Section 8.1.7. Rasters
1) Adding a Raster: Click the Add Raster Layer button
a) We are going to add land use layers for Uganda. Browse to the Raster folder within the
QGIS_Training_Data folder.
i) Next to File Name (where it says All files) click the arrow and choose GeoTIFF
ii) Select the file Africa_LandUse_43_ISCGM.tif
iii) Click Open

iv) The file should be added to the Map View and Map Legend windows
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v) We now want to move the land use raster to the bottom of the list so you can still
see all the vectors which you already added. Select the raster in the Map Legend
window and drag it below the Uganda_District_GAA layer. Note: You can expand the
Map Legend window to make it easier to drag the files if needed.

2) Properties of a Raster layer: Once you add a raster you can change the symbology,
coordinate system, and metadata for that file by going to its Properties.
a) Right click on Africa_LandUse_31_ISCGM and select Properties.
i) General tab: Here you can see the layer name, location, and coordinate system
(which you can change by clicking Specify).
ii)
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iii) Style tab: Here you can make changes to how the raster is visualized, although we
recommend staying with the defaults unless your raster is visualized in only one
color.
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i) Transparency tab – Here you can change the transparency of the layer so you can
see more or less of the layers underneath. Change the transparency to 25% and see
the difference between the layers.

ii) Metadata: Here you can check the metadata for the file and
add
more information if needed. If you scroll down to the Properties tab and scroll in
that window you will see the metadata which was entered by the Global
Administrative Areas website (GAA) when they made the file. Note: It’s a good idea
if you are going to be sharing your file with others that you fill out the metadata with
some information so other users know specifics about the file such as coordinate
systems, what the data represents, version of the file, etc. Close the Properties box
before proceeding.
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3. Adding Background Maps: In order to add a background map such as a street map or
satellite image, you will need to add a plugin called OpenLayers.
a) Go to the Plugins menu.
i) Select Manage and Install Plugins.

ii) Scroll down and highlight the OpenLayers Plugin and hit the Install plugin button.
iii) Once installed close the Plugin window. Note: Once you add the Plugin you shouldn’t
have to add it again.

v.29Nov2016

PREDICT Operating Procedures: QGIS - 30

a) To add a background to your map, go the Web menu and select the OpenLayers plugin.
You will notice that you can select background maps from OpenStreetMap, Google
Maps, Bing Maps, etc. For Now let’s add the Bing Aerial Map.
Note: Although you can add the map to your project, not all of these maps can be
exported when making maps for presentations or publications. You might have to test
which maps you are allowed to export.

b) When you add a new layer to the map you will notice that the layer will be placed at the
top of the list and will cover up all other layers. In the Map Legend window click on the
background layer and drag it to the bottom of the list. Your data will now be on top of
the background
map. You will need
to deselect the
land use layers in
order to see the
satellite image.
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a) It is possible that by adding the background image it changed your project’s coordinate
system.
i) To check this go to the Project file menu and choose Project Properties.
ii) Choose CRS and make sure the WGS 84 and not the WGS 84/Pseudo Mercator is
chosen.
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Section 8.1.8. Making Maps for Presentations & Publications
1. Open the New Print Composer button (you can also do this from the Project menu).
a) Give a name to this layout (Composer title), click OK.
b) The New Print Manager window will open. Listed below are some useful icons.

Pan

New Print Composer

Zoom

Duplicate Composer

Select/Move item

Composer Manager

Move item content

Load from template

Add new map

Print or export as PostScript

Add image
Add label
Add new legend

Export to an image format
Export print composition to SVG
Export as PDF

Add scale bar
Add basic shape
Add arrow
Add attribute table
Add HTML frame
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c) On the right side of the window there are 5 tabs. Note: In the Mac version you may only
see the Items, Composition, and Items Properties. If you would like to add the other
panels go to the View pull-down menu, choose Panels, and then add Command History
and Atlas generation.
i) Items: provides a list of items added to the canvas.
ii) Command history: history of all changes applied to the Print
Composer layout. Here you can undo and redo layout steps performed.
iii) Composition: here you can set paper size, orientation, page
background, number of pages, and print quality.
iv) Item properties: displays the properties for the selected item and
customizes settings for items like scale bars or labels.
v) Atlas generation: allows you to enable the generation of an atlas
(map
book) for the current Composer and gives access to its parameters.

Canvas
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2. Add New Map: To add data to the Composer click the Add new map button, crosshairs will
appear on the screen. Draw a box covering the area of the page. After you draw the box you
will see the map image you just made in QGIS visualized in the composer window.

3) Add a scale bar by clicking the Add new scalebar button.
a) With the crosshairs click on the image and a scale bar will appear.
b) To change the properties of the scale bar you can click on <scale bar> in the Items
window.
i) Under Main Properties the Style pulldown menu will allow you to change the style
of the scale bar.
ii) Under Units you can change the units of the scale bar.
iii) The Segment section allows you to change the number and size of the segments and
height of the scale bar.
iv) Display changes the style of the scale bar such as how far the text is away from the
scale bar, size of the box etc.
v) Fonts and colors allow you to change the color and font used for the scale bar.
vi) Position and Size changes the location of the scale bar on the page (you can do the
same thing by clicking the Select/Move Item icon and then select the scale bar and
move it.
vii) Rotation allows you to rotate the scale bar.
viii) Frame allows you to put a frame around the scale bar.
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ix) Background allows you to put a background behind the scale bar.
x) Item ID allows you to add an ID (this will change the name from <scale bar> to
whatever you type in the ID box in the Items window).
xi) Rendering has a function that will allow you to make the scale bar transparent or
exclude from exports.

4) To add a legend, click the Add new legend button
a) With the crosshairs click on the map and it will place the legend there (you can always
change the location with the Select/Move Item tool). Note: The legend tool will add all
the files listed in your QGIS Map Legend window even if they are not activated.
b) To change the Legend properties, highlight Legend in the Items window and go to the
Item Properties tab.
i) Main properties allow you to change the legend title, the alignment, and wrap text.
ii) Legend Items allows you to choose whether or not to auto update.
(1) If you do not want to show some of the layer names in your QGIS window then
uncheck the Auto Update and you will notice that you are now able to select the
tools below.
(2) The + tool will give you a list of layers you can add to the legend.
(3) Highlight a layer you would like to delete from the legend and hit the – button.
You will notice that the layer is removed from the legend.
(4) You can also change the order of layers by highlighting a layer and using the up
or down arrows.
(5) By clicking on the editing tool
and highlighting a layer, you can change
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the name of that layer.
iii) Fonts allow you to change the font style and color.
iv) Columns allow you to make multiple columns in your legend and then change the
properties of those columns.
v) Symbol allows you to change the width and height of the legend box.
vi) WMS LegendGraphic (Web map service) allows you to make a Web Map Service
(WMS) legend.
vii) Spacing allows you to change the space between and around text.
viii) Position and Size changes the location of the legend on the page (you can do the
same thing by clicking the Select/Move item icon and then selecting the legend box to
move it.
ix) Rotation allows you to rotate the legend.
x) Frame allows you to put a frame around the legend.
xi) Background allows you to put a background behind the legend.
xii) Item ID allows you to add an ID (this will change the name from Legend in the Items
window to whatever you typed in the ID box).
xiii) Rendering has a function that will allow you to make the legend transparent or
exclude from exports.
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5) Add a North Arrow:
a) Click the Add Image button.
b) Click on the image and draw a box where you would like the north arrow to be.
c) Under Items Properties tab open Search directories by clicking on the arrow next to it.
Images will appear in the box below, scroll through and choose the north arrow you
would like to use.
Click on the arrow.
You should notice
that the arrow now
appears in the box
you drew on the
map.
d) You can resize the
arrow by changing
the size of the box.
This is done by
dragging the box’s
corners to the
desired size.
6) Add a Graticule (evenly spaced horizontal and vertical lines used to identify
locations on a map often using latitude and longatitude):
a) Highlight Map under the Items window.
b) In the Items Properties
window click on the arrow
next to Grids to expand that
section.
c) Click the + button and you
should see Grid 1 show up in
the box below. Highlight Grid
1 and activate the box next
to Draw “Grid 1” grid, by
clicking on it. This will open
the grid properties which you
can fill out.
i) Choose Grid Type as Frame
and annotations only.
ii) For CRS, choose WGS 84 as the coordinate system so that the coordinates are
displayed as latitude and longitude.
iii) Interval Units set to millimeter. Note: you can keep this set to the default of Map
Unit, however, if your coordinates don’t show up change to millimeter or
centimeter and they will show up.
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iv) Interval will set the intervals between the numbers displayed on the graticule.
For this example set the interval to 100 for both X and Y.
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v) Scroll down to Grid Frame and set the Frame style to Exterior ticks and make
sure Left side, Right side, Top side, and Bottom side are all checked. This will
display the coordinates on all four sides of your map.
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vi) Activate the Draw coordinates button by clicking in the box next to it. Choose a
Format. Here we choose for latitude and longitude to be displayed as Decimal.
Left, Right, Top, and Bottom should all be set to Outside frame; and Left and
Right should also be set to Vertical. You should now see your graticule around
the map. Note: There have been people using the Mac version where the
graticule isn’t showing up in QIGS but is there when they export the map. We
have not been able to identify the problem yet, but are continuing to look into
the problem.
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6) Once you are happy with the layout (feel free to move the items on the map around to
make it more pleasing to the eye) you can Export the map as an image (.jpg) or .pdf file
a) Export as Image:
i) Browse: browse to where you want to save the file.
ii) File name: name the file you are saving.
iii) Save as type: choose the type of file you would like to save i.e. jpg or .tif.

b) Export as pdf:
i) Click OK if you get a warning about saving the file as a raster.
ii) Browse to where you would like to save the file.
iii) File name: give the file a name.
iv) Click Save.
7) Composer Manager: If you close the New Print Composer window, you can reopen the Print
Composer by clicking on the Composer Manager window.
a) Highlight the template you would like to open and click the Show button.
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Section 8.1.9. Glossary
Definitions and pictures are sourced from ESRI unless otherwise stated.
Attribute – Non-spatial information about a geographic feature in GIS, usually stored in a table
and linked to the feature by a unique identifier. For example, attributes of a river might include
its name, length, and sediment load at a gauging station. In raster datasets, information
associated with each unique value of a raster cell.
Attribute tables - A database or tabular file containing information about a set of geographic
features, usually arranged so that each row represents a feature and
each column represents one feature attribute. In raster datasets,
each row of an attribute table corresponds to a certain zone of cells
having the same value. In GIS, attribute tables are often joined or
related to spatial data layers, and the attribute values they contain
can be used to find, query, and symbolize features or raster cells.

Coordinates - A set of values represented by the letters x, y, and optionally z or m (measure),
that define a position within a spatial reference. Coordinates are
used to represent locations in space relative to other locations.

Coordinate System - Coordinate systems enable geographic datasets to use common locations
for integration. A coordinate system is a reference system used to represent the locations of
geographic features, imagery, and observations, such as Global Positioning System (GPS)
locations, within a common geographic framework.
Datum - The reference specifications of a measurement system, usually a system of coordinate
positions on a surface (a horizontal datum) or heights above or below a surface (a vertical
datum).
Geographic Coordinate System - A geographic coordinate system uses a three-dimensional
spherical surface to define locations on the earth. It includes an angular unit of measure, a
prime meridian, and a datum (based on a spheroid). The spheroid defines the size and shape of
the earth model, while the datum connects the spheroid to the earth's surface. A point is
referenced by its longitude and latitude values. Longitude and latitude are angles measured
from the earth's center to a point on the earth's surface. The angles often are measured in
degrees. Note: Because latitude and longitude are based on angles they do not have a
standard length throughout the globe. Because of this you cannot use a geographic
coordinate system if you plan to do any analysis on your data. Instead you will want to use a
projected coordinate system.
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Graticule - A network of lines representing the Earth's parallels of latitude and meridians of
longitude on a map.
Layer - The visual representation of a geographic dataset in any digital map environment.
Conceptually, a layer is a slice or stratum of the geographic reality in a particular area, and is
more or less equivalent to a legend item on a paper map. On a road map, for example, roads,
national parks, political boundaries, and rivers might be considered different layers. A layer can
also reference to a data source, such as a shapefile, coverage, geodatabase feature class, or
raster that defines how the data should be symbolized on a map.
Latitude – Latitude values are measured relative to the equator and
range from –90° at the South Pole to +90° at the North Pole. The
equator is considered the 0° of latitude and the y value in a coordinate
pair. Latitude is an angle measured from the earth's center to a point on
the earth's surface. The angles often are measured in degrees.
Image: http://geographyworldonline.com/tutorial/instructions.html

Longitude - Longitude values are measured relative to the prime
meridian. They range from –180° when traveling west to 180° when
traveling east. The prime meridian is considered the 0° of longitude and
the x value in a coordinate pair. Longitude is an angle measured from the
earth's center to a point on the earth's surface. The angles often are
measured in degrees.
Image: http://geographyworldonline.com/tutorial/instructions.html

Metadata - Information that describes the content, quality, condition, origin, and other
characteristics of data or other pieces of information. Metadata for spatial data may describe
and document its subject matter; how, when, where, and by whom the data was collected;
availability and distribution information; its projection, scale, resolution, and accuracy; and its
reliability with regard to some standard. Metadata consists of properties and documentation.
Properties are derived from the data source (for example, the coordinate system and projection
of the data), while documentation is entered by a person (for example, keywords used to
describe the data).

Prime Meridian - In a coordinate system, any line of longitude
designated as 0 degrees east and west, to which all other meridians are
referenced. The Greenwich meridian is internationally recognized as the
prime meridian for most official purposes, such as civil timekeeping.
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Projected Coordinate System - A projected coordinate system is defined on a flat, twodimensional surface. A projected coordinate system has constant lengths, angles, and areas
across the two dimensions. It includes a map projection, a set of projection parameters that
customize the map projection for a particular location, and a linear unit of measure. Different
projected coordinate systems are useful for different purposes, for example some projected
coordinate systems might preserve distance, area, true directions, or shape. Wikipedia has a
useful, detailed explanation of coordinate systems at
http://en.wikipedia.org/wiki/Coordinate_system
Raster - A spatial data model that defines space as an array of equally
sized cells arranged in rows and columns, and composed of single or
multiple bands. Each cell contains an attribute value and location
coordinates. Unlike a vector structure, which stores coordinates
explicitly, raster coordinates are contained in the ordering of the
matrix. Groups of cells that share the same value represent the same
type of geographic feature.
Shapefile - A vector data storage format for storing the location, shape, and attributes of
geographic features. A shapefile is stored in a set of related files and contains one feature class.
There 3 mandatory files (first 3 listed below) that make up a shapefile, however, there may be
files for the shapefile containing additional information:
.shp – shape format; the feature geometry itself
.shx – shape index format; a positional index of the feature geometry to allow seeking
forwards and backwards quickly.
.dbf – attribute format; columnar attributes for each shape, in dBase IV format
.prj – projection format; the coordinate system and projection information, a plain text
file describing the projection
.xml – geospatial metadata in XML format
.sbn and .sbx – a spatial index of features
Sphere vs. spheroid Sphere – a perfectly round geometrical and circular object in three-dimensional space
Spheroid – a spherelike but not perfectly spherical body
Symbology – The set of conventions, rules, or encoding that define how geographic features
are represented with symbols on a map. A characteristic of a map feature may influence the
size, color, and shape of the symbol used.
Vector – A coordinate-based data model that represents geographic features as points, lines,
and polygons. Each point feature is represented as a single coordinate pair, while line and
polygon features are represented as ordered lists of vertices. Attributes are associated with
each vector feature, as opposed to a raster data model, which associated attributes with grid
cells. Examples of a vector include points representing sampling locations, line representing
roads, and polygons representing national parks.
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Section 8.1.10. Data Download
Global Administrative Areas – Country administrative layers (country, state, county, etc)
http://www.gadm.org/country

Choose your Country
File format = Shapefile
Click OK
On the next page click Download
Protected Planet – National parks and protected areas
For this site you have to set up an account but it’s free
http://www.protectedplanet.net/

International Steering Committee for Global Mapping – National data, Global elevation, Global
land cover, and Global vegetation
For this site you will have to register to download data but it’s free.
Home page - http://www.iscgm.org/
Data download page - https://www.iscgm.org/gmd/
IUCN (International Union for Conservation of Nature) Red List of Threatened Species –
Download shapefiles on location information for threatened species.
http://www.iucnredlist.org/technical-documents/spatial-data

Natural Earth – Here you can download different data from administrative boundaries to
shaded relief rasters.
http://www.naturalearthdata.com/

GrassWiki Geodata – This site as a list of data sites. Click on one of the layers you are interested
in and it will take you that particular website.
http://grasswiki.osgeo.org/wiki/Geodata

United States Geological Survey (USGS) - This website has many links for data worldwide.
http://landcover.usgs.gov/landcoverdata.php#regional

Andreas Hamann’s website – Climate data for North America, South America, and Europe
http://www.ualberta.ca/~ahamann/data.html

Section 8.1.11. Helpful Online Tools & QGIS Training Videos
Federal Communications Commission – Site that converts latitude and longitude between
Degrees Minutes Seconds to Decimal Degrees
http://transition.fcc.gov/mb/audio/bickel/DDDMMSS-decimal.html
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Geographic/UTM Coordinate Converter – Converts coordinates between latitude and
longitude and UTM
http://home.hiwaay.net/~taylorc/toolbox/geography/geoutm.html

National Oceanic and Atmospheric Administration (NOAA) Understanding Datums,
Coordinate Systems, and Map Projections
http://coast.noaa.gov/digitalcoast/_/elearning/datums/player.html

ESRI About Coordinate Systems and Map Projections
http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=About_coordinate_systems_and_m
ap_projections

There are many videos online which you might be interested in using as a reference. Below are
just a few we thought were useful and easy to follow.
 The Interface: http://qgis-tutorials.mangomap.com/post/79334660226/qgis-video-tutorials-module1-the-interface


Creating a basic map: http://qgis-tutorials.mangomap.com/post/82295156067/qgis-video-tutorialsmodule-2-creating-a-basic





Classifying vector data: http://qgis-tutorials.mangomap.com/post/83730031877/qgis-videotutorials-module-3-classifying
Creating a map for print: http://qgis-tutorials.mangomap.com/post/84321475284/qgis-videotutorials-module-4-creating-a-map
Creating vector data: http://qgis-tutorials.mangomap.com/#
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